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Introduction
You can add scripted title object to your title projects created to
be broadcasted using ForwardT Software. Scripted title objects
are title objects controlled by a script: special program code.
Scripted title objects are intended to solve problems that can’t
be solved using simple title objects and elements or that can be
solved this way but it requires too much additional settings.
Script is a part of title object. When working, script may use
data received from other programs, e.g., duration and name of a
video file being reproduced in FDOnAir.
SoftLab-NSK has developed and is glad to propose you to use
scripted objects of two types:
●● open source (distributed free);
●● closed source (paid software).
This document presents information on using free scripted title
objects.
You can create your own scripted title objects. For more
information please contact out technical support.
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General information

Scripted title objects
Scripted title objects (or scripted objects) mean title objects
controlled by a script: special program code.
A scripted object includes:
●● title elements (their type and quantity depend on
problem to be solved);
●● script – a program code written in the JScript.NET
programming language.
Ready-made scripted objects are stored in template files:
*.SLTitleTmpl files (e.g. the TSF_MClip scripted object is stored in
the TSF_MClip.SLTitleTmpl template file).
To add a scripted object to your title project, load data from the
corresponding template and set the object parameters. To load
data and set the parameters, use FDTitleDesigner application.
When a scripted object is loaded to a title project, there is no
connection between it and its template file, so the template
file may be deleted or moved to another folder according to the
user’s discretion.

Open source scripted objects
The script code of the open source scripted objects is available
for user: after the loading of a title project, the Scripts (1) tab
appears in the FDTitleDesigner’s window.
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In the Scripts tab the script code is displayed. The user can view
the code and modify it.
The open source scripted objects are stored in the TSF (Title
Scripts Free) library. The table below presents open source
scripted objects and their purposes.
Имя

Назначение

TSF_Age

Automation of displaying of information on age restrictions for the current
TV program. The information is displayed once during video playback. The
displaying starts in a period from the playback beginning specified by user

TSF_MClip

Automation of titling for musical video: to show information on
musical video during its playing back. Titles are shown twice during
the musical video playing back: at the beginning and at the end

TSF_AdvMix,
TSF_AdvMixPS,
TSF_AdvMixPS2

Displaying on a specified screen area ads of different types: video,
images, scrolling text. Scripted objects differ in their ways of scrolling
text displaying

TSF_Announce

Displaying of announcement on the next video (program). The
announcement is displayed once during the video playing back

TSF_IU

Works in the same way as the FDImageUpdater program and is
intended for displaying images with information received from
different sources

TSF_MovieList

Works in the same way as the MovieList title element, but has some
additional features

TSF_RollCrawl

Works in the same way as the RollCrawl title element, but has some additional features

TSF_CaptionPro

Works in the same way as the Caption title element, but has some additional features

TSF_AdCountDown Displaying of countdown timer until the end of the advertisement

You can download for free a set of templates of the TSF scripted
objects library as a ZIP archive from SoftLab-NSK web-site (at
the «Download» section).
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Closed source scripted objects
In closed source scripted objects the source code of the script is
not available for user. Such objects are distributed for a fee as a
library.
The table below presents closed source scripted objects included
in the TS1 (Title Scripts 1) library, and their purposes.
Имя

Назначение

TS1_MuzClip

Automation of titling for musical videos: to show information on
musical video during its playing back. Titles are shown twice during
the musical video playing back: at the beginning and at the end

TS1_Header

Displaying of titled groups of scrolling text: the header of the group
of scrolling text ads is displayed during playing back this group

TS1_Promo

Displaying of required text (caption) when broadcasting a specified
video, e.g. details of the current program. The caption displaying
starts in a period after the beginning of the program and ends the
same period before its end. Time indentations are to be specified by
user

TS1_Promo2

Displaying of announcement on next video (program). The
announcement is displayed once during the video playing back

TS1_RollCrawlPro

Displaying of ads, split to three parts: main text, first and second additional
texts. Each part is displayed on different screen areas, specified by user

TS1_RollCrawlPro2

Displaying of ads consisting of scrolling text and two additional
texts, displayed on a different screen areas, specified by user

TS1_AdvMixPro

Displaying of ads of different types (images, videos, scrolling texts)
with an ability to display additional information on two separate
areas

TS1_TVGuide

Sequential displaying of program guide for subsequent several hours
for different channels

TS1_Horo

Displaying of horoscope for different signs of the zodiac

TS1_DB2Text

Displaying of ads text of which is read automatically from a database

TS1_InfoBar

Displaying of one-line news feed

TS1_InfoBar2

Displaying of news feed. For each news item its subject (header) and text
consisting of two lines (each line can have its specific formatting) are displayed. It is possible to display information on current time and air temperature

TS1_InfoBar3

Displaying of news feed. For each news item its subject (header)
and text are displayed. This script is a simplified version of the
TS1_InfoBar2 scripted object

TS1_SMSCrawl

Displaying of SMS as a scrolling text

TS1_SubTitles

Automation of subtitles displaying
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For more information on the TS1 library see the «Closed source
scripted title objects. TS1 – a library of paid scripted title
objects» User’s Guide.
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Important: To play back in FDOnAir title projects containing closed source
scripted objects on the board you need to have a license for
using the relevant library of scripted objects.

To play back in FDOnAir title projects without using the board
(in SLTitlePreview window) you don’t need the license.
You can set title projects containing paid scripted object in
FDTitleDesigner on any computer regardless of whether there
is the license or not.
When loading title projects containing closed source scripted
objects to the FDTitleDesigner program regardless of whether
there is the license or not a warning message appears.

Loading of scripted objects to a title project
The scripted object library is a set of files with the
*.SLTitleTmpl extension, which names correspond to the scripted
object names, e.g., the TSF_AdvMix scripted object is stored in
the TSF_AdvMixPro.SLTitleTmpl file.
Note:

Files with the *.SLTitleTmpl extension are so-called template files.
Template files may contain regular title objects as well as scripted
title objects.

The picture below presents a folder containing template files of
the scripted title objects from the TSF library.
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To load a scripted title object to a title project, load the template
of needed scripted object and configure it.
To do so:
1. Download to your computer the library of scripted objects
from SoftLab-NSK website (the Download section > Forward
T Products > TSF – Free library of scripted title objects) and
unarchive it.

2. In FDTitleDesigner open or create the title project where
you need to add the scripted title object.
3. To load the scripted object from the template, click File >
Import Object Template... (1).

1

You can also use the Import Object Template... command from
the context menu (2) right-clicking on the Object Tree panel.
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2

4. In the Import Object Template... window that opens select the
template file you need and click Open (4).

4

5. The scripted title object will be loaded to your title project:
●● in the working area of the project the title elements of
the scripted object are displayed (5). The title elements
have the size and location specified in the template;
●● in the Object tree window the added scripted object and
its title elements are displayed (6).
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6

6. The scripted object is loaded and ready to be configured.
You can find more information on how to configure the
scripted object below in this User`s Guide.
When a scripted object is loaded to a title project, there is no
connection between it and its template file, so the template
file may be deleted or moved to another folder according to
the user’s discretion.

Data source for script
When working, script controls task loading to the scripted
object’s title elements. Script receives information on what data
needs to be loaded from a source of data for script specified by
user.
Scripts developed by SoftLab-NSK can use as source:
●● task file. Usually, it is a text file (*.txt file);
●● FDOnAir schedule comments.
Some scripts can use both types of data source, others only one.
If script is able to work with data sources of both types, when
working, it can only appeal to one source – read either FDOnAir
schedule comments or task file. It is necessary to specify the
type of source to be used. If you need to use both types at the
same time, add to your title project two scripted objects of the
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same name and configure one of them for working with task file
and another with schedule comments.
Data sources for script are to be prepared by user. This
document presents information about writing lines in task file
and comments text for different scripts.

Change of the task being executed by the scripted object in FDOnAir
In FDOnAir you can change the task being executed by the
scripted object.
The task of the scripted title object can be changed
automatically according to the schedule or interactively by
pressing a button (as for regular title objects).
To do so:
1. Prepare your task file for the scripted object.
2. Load the title project containing the scripted object to
FDOnAir.
3. Configure the file page for the required title object:
1. Open the Title objects file page pressing the button (1).

1

2. On the file page press the Customize button (2) – the
elements for setting the folder properties appear in the
window (3).
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2

3

3. In the Title Object list (4) select the title object for which
you want to change a task.

5
4

4. Pay attention to which filter is displayed in the File filter
line (5). If necessary, select the required filter in the list.
E.g. *.txt. For more information on the task file type, see the
description of the appropriate scripted object.
5. Specify the folder, where the task file is stored: to do so,
click Set folder (6).
6

6. In the window that opens select the folder containing task
file(s). To close the window, left-click on task file and click
Open (7).
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7. The list of the files (8) with the extension that corresponds
to the extension specified on the File filter is displayed on the
file page.
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4. To add to the schedule a command to change a task, do the
following:
1. In the FDOnAir schedule place the cursor to the required
line (9).

11

9

10

2. On the Title objects file page, double-click on the name of
the task file you need to load (10). The command for loading
of the selected file to the specified title object will be added
to the schedule (11).
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5. To change a task by pressing on a button, do the following:
1. On the file page, left-click on the name of the task file you
need to load to the scripted object (12).
13

12

2. Press on the Load object task immediately button (13): the
selected task will be immediately loaded to the scripted
object.
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Important: The Load the task immediately button becomes clickable only after
selecting a task file. If you have not selected any task file, the
button is not clickable.

Preview
1. General information
A way of previewing scripted object’s work depends on whether
the script uses during its work data received from FDOnAir or
not.
●● if during its work the script uses data received from
FDOnAir, you can preview its work by starting the
operation of your schedule in FDOnAir. You can use
for previewing one of the following programs:
●● FDPreview, intended for previewing audio and
video on the board’s input/output;
●● SLTitlePreview, intended for previewing audio and
video from FDOnAir output without using a board.
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●● if during its work the script does not use data
received from FDOnAir, you can preview its work in
FDTitleDesigner window.

2. Preview in FDTitleDesigner
In FDTitleDesigner window you can preview only work of
scripted objects that do not use data received from FDOnAir.
To do so:
1. Configure the scripted object.
2. To start the preview, click Start Preview (1).

1

2

3. To stop the preview, click Stop Preview (2).

3. Preview in FDPreview window (using the board)
To do so:
1. Using FDTitleDesigner, prepare your title project
containing scripted title object.
2. Launch FDOnAir.
3. Create a schedule in FDOnAir:
●● if you use schedule comments as a task for script, add
comments to your schedule;
●● if the scripted object you want to preview is intended
for titling of concrete videos, add to your schedule
commands for playing back necessary video files.
4. Load your title project containing scripted object to
FDOnAir:
●● in the Settings window on the Title objects tab click the
Title project button (3);
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4

●● in the dialog window that opens specify prepared title
project;
●● close the Settings window by clicking the Close button
(4).
5. In the main window of FDOnAir enable displaying of titles
pressing F7 (5);
5
6

7

6. Enable scripted title object. You can choose one of two ways
to do so:
●● using the button for enabling/disabling title objects to
which required title object is assigned (6);
●● adding to the schedule command for enabling a title
object (7).
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7. Launch FDPreview. You can launch it using menu Start >
ForwardT Software > Tools > FDPreview.

If necessary, configure the program.
8. In FDOnAir launch the schedule execution.
9. In FDPreview launch preview.

For more information on working with FDPreview see the
«FDPreview. Program for Previewing of Audio and Video on
Boards Inputs/Outputs» User’s Guide.
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4. Preview in window of SLTitlePreview (without board)
To do so:
1. Using FDTitleDesigner, prepare your title project
containing scripted title object.
2. Launch SLTitlePreview, using one of these ways:
●● using menu Start: Programs > ForwardT Software > Tools
> TitlePreview.

●● opening ~\SLTitlePreview\SLTitlePreview.exe,
where ~ denotes the full path to the folder where
ForwardT Software is installed.
SLTitlePreview’s window opens.

3. If necessary, configure the SLTitlePreview program: leftclick on the program window’s header (1) and in the context
menu that opens select Settings (2).

1

2

In the window that opens make necessary settings. For
more information on working with SLTitlePreview see the
«Viewing Data on the Computer Monitor» section in the
«FDOnAir. Additional Sections» User’s Guide.
4. Launch FDOnAir.
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Important: Launch FDOnAir after launching SLTitlePreview. However,
when you finish working first close FDOnAir and then
SLTitlePreview.
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5. In FDOnAir in the Settings window do the following:
●● on the Configuration tab select the Videoprocessor as a
Video device (1);

1

2

●● click Apply changes (2);
●● on the Title objects tab click Title project (3) and in the
window that opens specify the title project you
prepared;

3

4

●● close the Settings window by clicking Close (4).
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6. Make your schedule in FDOnAir:
●● if you use schedule comments as a task for script, add
comments to your schedule;
●● if the scripted object you want to preview is intended
for titling of concrete videos, add to your schedule
commands for playing back necessary video files.
7. In the main window of FDOnAir enable displaying of titles
pressing F7 (5);
5
6

7

8. Enable scripted title object. You can choose one of two ways
to do so:
●● using the button for enabling/disabling title objects to
which required title object is assigned (6);
●● adding to the schedule command for enabling a title
object (7);
9. In FDOnAir launch the schedule execution.
10. Open the SLTitlePreview’s window for previewing.
For more information on working with SLTitlePreview see
the «Viewing Data on the Computer Monitor without Using
an FD300 Board. The SLTitlePreview Program» section in the
«FDOnAir. Additional Sections» User’s Guide.
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How to use scripted objects
To use scripted objects, do the following:
1. Read the instructions on using object in User’s Guide.
2. Prepare files needed for setting and work of script (task file,
style collection (*.efc file), etc.).
3. In FDTitleDesigner do the following:
1. Create or open title project.
2. Load to the title project scripted object from template.
3. Set the scripted object.
4. Save the title project.
4. In FDOnAir do the following:
1. Load the title project you prepared.
2. Make a schedule, enable displaying of titles.
3. Launch schedule execution.

Substitution file
In some scripted title objects you can use files for text
substitution.
Files for substitution are intended to replace one text in task
file to another automatically during working of the script.
File for substitution is a text file with information on
replacement of one symbol combinations to another.
Each record in the file has the following format:
Input_line Separator Output_line

where:

●● Input_line denotes a symbol combination that has to be
found in task file and replaced.
●● Separator denotes a symbol indicated in script settings
as the Separators parameter.
●● Output_line denotes a symbol combination intended to
replace the Input_line in the task file.

Each record in the file starts with a new line.
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Important: Use the same separator symbols in the task file and file for
substitution intended for one scripted title object.
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Example: In the task file in the text of RollCrawl before each phone
number is preceded by «Call».

Using file for substitution you can replace «Call» by a picture,
for example

, stored in the phone.gif file.

To do so, add to your file for substitution the line like this:
Call|<PC 50 phone.gif>,

where:

●● Call denotes the line to be found and replaced;
●● | is a separator used in the task file as well as in the
file for substitution;
●● <PC 50 phone.gif> denotes the line to replace. In this
case, it is a tag intended to display pictures. For more
information on using tags see the «Tags of Formatting»
subsection in the «Types of Title Elements» section
in the «FDTitleDesigner. Title Project Editor» User’s
Guide.

The picture below presents previewing of RollCrawl in
FDTitleDesigner’s window.
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Open source scripted title objects

TSF_Age: age restrictions displaying
1. Purpose
The TSF_Age scripted title object is intended for displaying
information on age restrictions of the current TV program.

How the TSF_Age scripted title object works:
●● some time before beginning of execution of next
command for playing back a video (in FDOnAir
schedule) the script gets information on the video file
to be played back;
●● the script searches a SLIni file for this video file or a
common SLIni file – default.SLIni (see p. «2. SLIni
file»);
●● if it can find the file and it contains the line with
information on age restriction, the script reads this
information and at the beginning of execution of
command to play back a video, displays a logo of
age restriction;
●● if there is no SLIni file or SLIni file does not
contain information on age restrictions, the script
does nothing;
●● time of displaying of logo with information on age
restrictions is to be specified by user.
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Information on age restriction can be presented as:
●● image;
●● video;
●● text.

2. SLIni file
An SLIni file is a text file with *.SLIni extension that contains
video file’s displaying settings (for more information see the
«Video Files Playback Settings File» section in the «FDOnAir.
Additional Sections» User’s Guide).
For recording of information on age restrictions to SLIni file a
line as follows is added:
Age = X+

where:

●● Age denotes the parameter name used for recording
age restrictions;
●● X+ denotes the parameter value. The value is to
contain a number and «+» (without spaces), e.g., 0+,
6+, 12+, 16+, 18+.

You can write manually a record on age restrictions in SLIni
file using Notepad or automatically using the TrimEditor utility
program.
To add a record on age restrictions in SLIni file using
TrimEditor, do the following:
1. Launch FDOnAir.
2. Laun ch TrimEditor:
●● for videos added to your FDOnAir schedule, click on
the corresponding schedule row in the Length field (1);

1

●● for videos displayed in the list of the Films files
page (2), use the TrimEditor command in the context
menu (3). To open the context menu, right-click on the
video file’s name.
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2

3

3. In TrimEditor’s window that opens click Properties (4).

4
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4. In the window that opens make the following settings:
●● select the Age group check box (5);
●● in the drop-down list (6) select the age group.

5

6
7

5. Close the window saving all the settings you made by
clicking Save (7).
6. Close TrimEditor by clicking OK (8).

8

There are two ways to use SLIni files:
●● to create a separate SLIni file for each video file. In
this case the SLIni file’s name and the name of the
corresponding video file are to be the same.
The picture below presents an example of folder that
contains an SLIni file for each video file;
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●● to create one SLIni file for all video files stored in the
folder. In this case the SLIni file should be named
default.SLIni. It allows you, for example, to distribute
your videos to folders according to age categories: to
store video intended for audience of the same age in
the same folder.

3. Task file
A task file for the TSF_Age scripted title object is a text file with
*.txt extension.
The task file contains records established a correspondence
between the Age parameter value in the SLIni file and data to
be loaded to title elements of the TSF_Age scripted title object.
Each line has the following structure:
Age_record Separator Task_to_be_shown_in_titles

where:

●● Age_record denotes a value of the Age parameter in the
SLIni file;
●● Separator is a character specified when setting the
scripted object in FDTitleDesigner as Separator (the |
character is set by default);

30

●● Task_to_be_shown_in_titles denotes the task to be
showed in the titles. How to compose the task depends
on what you need to show in the titles:
●● for image specify the absolute or relative path
to the image file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
12+ | pictures\12+.tga
Age parameter value
in the SLIni-file

Separator

Relative path to the image file

●● for video specify the absolute or relative path
to the video file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
16+ | pictures\16+.avi
Age parameter value
in the SLIni-file

Separator

Relative path to the video file

●● for text specify the text you want to be shown in
the titles.
18+ | 18+
Age parameter value
in the SLIni-file

Separa- Text to be shown in the titles
tor

The picture below presents an example of a task file opened in
Notepad.

4. Title elements of the object
4.1. List of the elements
In the table below the title elements contained in the TSF_Age
scripted title object are listed, specifying their type and purpose.
Name

Type

Purpose

Main

Caption

Auxiliary element used by the script object during its work. Change
of its size or location does not affect the work of the script object and
showing of the information in titles.
It is recommended not to change the default values of this element.

Backgr

AnimLogo Used to display a background image. Specify the size and location of

this title element if you need to display a background image.
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Name

Type

Purpose

Movie

AnimLogo Used to playback video files. Specify the size and location of this title

Descr

Caption

element if your task file contains records to display video files.

Used to display text or graphic information. Specify the size and
location of this title element if your task file contains records to
display graphic files or text.

4.2. Size and location
User can change size and location of any title element of the
TSF_Age scripted title object.

5. Working with the scripted object
1. Preparation for work:
●● prepare your task file for the scripted object (see p.
«3. Task file»);
●● if your task file contains records to display a text,
prepare a style collection file for text design (*.efc). For
more information on how to create a style collection
file see «ForwardTitling. Graphic Editor» User’s Guide;
●● if your task file contains records to display image or
video files, prepare the files;
●● if you need to display a background, prepare a
corresponding image file.
2. In FDTitleDesigner create a title project or load one created
before where you need to add a TSF_Age scripted title object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) clicking on the FDTitleDesigner
Object Tree panel and select the Import Object Template...
command (4).
1
3
2
4
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4. In the Import Object Template... window that opens select the
TSF_Age.SLTitleTmpl file (5) and click Open (6).

5

6

5. The TSF_Age scripted title object will be loaded to your title
project:
●● in the object tree the added TSF_Age object (7) and its
elements are displayed;
●● in the working area of the project title elements of
the TSF_Age scripted object are displayed. After the
loading all title elements have the same size and
location (8) specified in the template.

7

88

Important: Do not change the composition, type and name of title elements
of the scripted object. But you can change the name of the
scripted object.
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6. To start setting parameters of the scripted object, in the
Object Tree window (1) click on the name of the TSF_Age
scripted object (2).
1
2

3

7. In the Properties window in the TaskName line (3) specify the
name of your task file.
8. If the ScriptProperties list (4) is minimized expand it clicking
on the icon (5).

5

4

6
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9. Specify values of the script parameters (6):
●● Separators: the separator character used in your task
file (see p. 3 «Task file»);
●● Duration: duration of showing of the data (seconds);
●● Delay: Time from the start of the video until the start
of displaying age restriction information (seconds);
●● Fade in/out: Time of appearing/disappearing of titles
(fade in/out; seconds);
●● Background: a full path to the background image file
(optional parameter);
●● Styles file: a full path to the style collection file (*.efc).
Optional parameter. Specify this parameter value if
your task file contains records for displaying text data;
●● Description style: index of the style in the style
collection file used for design of the text of the titles
(enumeration of styles starts from 0) (optional
parameter);
●● SLIni Key: name of the parameter used in the SLIni file
for recording of age restriction information. By default
the Age name is specified.
10. If your task file contains records for displaying videos, set
the Movie title element (1): specify its size, location and if
necessary set other parameters available for setting.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section on the
«FDTitleDesigner. Title Project Editor» User’s Guide.

11. If your task file contains records for displaying image files or
text, set the Descr title element: specify its size, location and
if necessary set other parameters available for setting.
12. If you need to display background image, set the Backgr title
element: specify its size, location and if necessary set other
parameters available for setting.
13. Save your project.
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6. Preview
To preview your TSF_Age scripted object, start the schedule
execution in FDOnAir. You can preview your project using
FDPreview or SLTitlePreview.
For information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_MClip: titling for musical video
1. Purpose
The TSF_MClip scripted title object is intended for automation
of titling for musical video: to show information on musical
video during its playing back. Titles are shown twice during the
musical video playing back: at the beginning and at the end.

Shakira
Waka Waka

When working, the TSF_MClip scripted title object uses
information received from FDOnAir: name of the video file
being played back and its duration. Based on the information it
received the script controls the loading of data to title elements
of the object and time of showing the titles.
To title elements you can load the following types of data:
●● image;
●● video;
●● text.
When titling one video, you can load to the TSF_MClip scripted
title object data of only one type, i.e. an image or a video or a
text. It is impossible to load to the TSF_MClip scripted title object
data of two different types, e.g. an image and a text.
In one title project you can use several TSF_MClip scripted title
objects. When adding several objects index numbers are added
automatically to their names: TSF_MClip, TSF_MClip_0,
TSF_MClip_1, etc.
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Example: If you need for titling your video to displaying text containing

performer’s name (1) and an image (as a background) (2), add
two TSF_MClip scripted title objects: one for a text, and another
for the image.

1

Shakira
Waka Waka

2

Shakira
Waka Waka

For loading a TSF_MClip scripted title object the template file
TSF_MClip.SLTitleTmpl is used.

2. Data sources for the scripted object
The TSF_MClip scripted title object can receive information on
what data are to be loaded to title elements of the object from
one of the following sources:
●● task file of the scripted title object;
●● FDOnAir schedule comments.

88

Important: When working, the scripted object can use only one data source:
either schedule comments, or task file. It is impossible to use at
the same time schedule comments and task file.
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2.1. Task file
A task file for the TSF_MClip scripted title object is a text file
with *.txt extension.
The task file contains a list of videos with tasks to be loaded to
the scripted title object when playing back these videos.
Each record has the following structure:
Video_file_name Separator Task_to_be_shown_in_titles

where:

●● Video_file_name denotes the absolute or relative path to
the video file, for which the task in the current line is
intended. Relative path is to be specified relatively to
location of the task file for the scripted object;
●● Separator is a character specified when setting the
scripted object in FDTitleDesigner as Separator (the |
character is set by default);
●● Task_to_be_shown_in_titles denotes the task to be shown
in the titles. How to compose the task depends on
what you need to show in the titles:
●● for image specify the absolute or relative path
to the image file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
D:\Clips\shakira_-_Loca.avi |D:\Titles\Shakira_Loca.bmp
Absolute path to the video file, for
which the task in the current line is
intended

Separator

Absolute path to the image file

●● for video specify the absolute or relative path
to the video file. Relative path is to b e specified
relatively to location of the task file for the scripted
object.
D:\Clips\shakira_-_Loca.avi |D:\Titles\SL_Muz_info.avi
Absolute path to the video file, for
which the task in the current line is
intended

Separator

Absolute path to the video file

●● for text specify the text you want to be shown in
the titles.
If you need to display a text that contains several
lines put the Separator in the place you need to feed
the line. If you put a space character between the
separator and the text line, when displaying, the
text will be started from the space character.
Separator

D:\Clips\shakira_-_Rabiosa.avi |Shakira |Rabiosa
Absolute path to the video file, for which the
task in the current line is intended

Text string #1

Text string #2
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Text lines can contain formatting tags. For more
information on using formatting tags see the «Tags
of formatting» paragraph in the «Types of Title
Elements» section of the «FDTitleDesigner. Title
Project Editor» User’s Guide.
Example of a line containing formatting tags:
D:\Clips\shakira_-_Rabiosa.avi|<St 1>Shakira |<St 4>Rabiosa.

In this example, using the <St 1> and <St 4> tags,
we are specified text design styles (as a source of
styles collection the file specified in the scripted
object settings is used).
The order of lines in the file is arbitrary. One task file can
contain information on titling of several videos, regardless of
their presence in FDOnAir schedule.
The picture below presents an example of a task file opened in
Notepad.

2.2. FDOnAir schedule comments
The picture below presents an example of a schedule containing
comments intended for using by the TSF_MClip scripted title
object.

In the schedule the comment line is to be placed immediately
before the video, the data of which the comment includes.
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The text of comment should have the following structure:
Comment_tag Space Task_to_be_shown_in_titles

where:

●● Comment_tag denotes a word or a character
specified by user when setting the scripted object
in FDTitleDesigner in the Comment tag parameter
(in the examples below as a comment tag the word
«mclipinfo» is used);
●● Space denotes space character;
●● Task_to_be_shown_in_titles denotes the task to be shown
in the titles. How to compose the task depends on
what you need to show in the titles:
●● for image specify the absolute or relative path
to the image file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
Example:
mclipinfo D:\Users\U_R\Title_tasks\Shakira_Loca.bmp
Comment
tag

Space

Absolute path to the image file

●● for video specify the absolute or relative path
to the video file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
Example:
mclipinfo D:\Users\U_R\Title_tasks\SL_Muz_info.avi
Comment
tag

Space

Absolute path to the video file

●● for text specify the text you want to be shown in
the titles.
If you need to display a text that contains several
lines put the Separator in the place you need to
feed the line. If you put a space character between
the separator and the text line, when displaying,
the text will be started from the space character.
Example:
Comment
tag

Text string # 1

Text string # 2

mclipinfo Shakira|Waka Waka
Space

Separator

Text lines can contain formatting tags. For more
information on using formatting tags see the «Tags
of formatting» paragraph in the «Types of Title
Elements» section of the «FDTitleDesigner. Title
Project Editor» User’s Guide.
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3. Title elements of the object
3.1. List of the elements
In the table below the title elements contained in the TSF_MClip
scripted title object are listed, specifying their type and purpose.
Name

Type

Purpose

Main

Caption

Auxiliary element used by the script object during its work. Change
of its size or location does not affect the work of the script object and
showing of the information in titles.
It is recommended not to change the default values of this element.

Movie

AnimLogo Used to playback video files. Specify the size and location of this title

Descr

Caption

element if your task file contains records to display video files.

Used to display text or graphic information. Specify the size and
location of this title element if your task file contains records to
display graphic files or text.

3.2. Size and location
User can change size and location of any title element of the
TSF_MClip scripted title object.

4. Working with the scripted object
1. Preparation for work:
●● if necessary, prepare your task file for the scripted
object (see p. «2.1. Task file»);
●● if your task file contains records to display a text,
prepare a style collection file for text design (*.efc). For
more information on how to create a styles collection
file see «ForwardTitling. Graphic Editor» User’s Guide.
2. In FDTitleDesigner create a title project or load one created
before where you need to add a TSF_MClip scripted title
object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) clicking on the FDTitleDesigner
Object Tree panel and select the Import Object Template...
command (4).
1
3
2
4
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4. In the Import Object from Template window that opens select
the TSF_MClip.SLTitleTmpl file (5) and click Open (6).

5

6

5. The TSF_MClip scripted title object will be loaded to your
title project:
●● in the object tree the added TSF_MClip object (7) and its
elements are displayed;
●● in the working area of the project title elements of
the TSF_MClip scripted object are displayed. After the
loading, all title elements have the same size and
location (8), specified in the template.

7

8
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Important: You can not change the composition, type and name of title

elements of the scripted object. But you can change the name of
the scripted object.

6. To start setting parameters of the scripted object, in the
Object Tree window (1) click on the name of the TSF_MClip
scripted object (2).

1
2

3

7. In the Properties window in the TaskName line (3) specify the
name of your task file.
8. If the ScriptProperties list (4) is collapsed, expand it clicking
on the icon (5).

5

4
6

9. Specify values of the script parameters (6):
●● Duration: duration of showing of the data (seconds). If
you need to display a video file using the title object,
the value set in the parameter is ignored and the
duration of showing is set automatically as equal to
the duration of the video file;
●● Delay: time period (seconds):
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●● first showing of the titles: from the beginning of
playing back of the video in FDOnAir (video which
is to be titled) until the beginning of titling;
●● second showing of the titles: from the end of
titling until the end of playing back of the video in
FDOnAir (video which is to be titled);
●● Fade in/out: time of appearing/disappearing of titles
(fade in/out; seconds);
●● Styles file: a full path to the style collection file (*.efc).
Optional parameter. Specify this parameter value if
your task file contains records for displaying text data;
●● Style index: index of the style in the style collection file
used for design of the text of the titles (numeration of
styles starts from 0);
Note:

For design of different parts of the text with different styles use
formatting tags. See an example in p. 2 «Data sources for the scripted
object».
For more information on properties of title elements of different types
see the «Types of Title Elements» section on the «FDTitleDesigner.
Title Project Editor» User’s Guide.

●● Separator: the separator character used in your data
source (task file or schedule comments);
●● Use comments: denotes the data source for the scripted
object:
●● False, if you want to use task file as a data source
for the scripted object; schedule comments are not
used;
●● True, if you want to use schedule comments as a
data source for the scripted object; task file is not
used;
●● Comment tag: a word or a character from which
schedule comments should be started, intended for the
scripted object being set as a data source. Specify the
comment tag if you use schedule comments as a data
source for your scripted object.
10. If your data source for the scripted object contains records
for displaying videos, select the Movie title element in the
Object Tree window and set it: specify its size, location and if
necessary set other parameters, available for setting.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section on the
«FDTitleDesigner. Title Project Editor» User’s Guide.

11. If your task file contains records for displaying image files
or text, select the Descr parameter in the Object Tree window
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and set it: specify its size, location and if necessary set other
parameters, available for setting.

88

Important: Specify the styles collection file and style index you want to be

used for design of your text in parameters of the scripted object.
12. Save your project.

5. Preview
Previewing of working of the TSF_MClip titling scripted object
is impossible in FDTitleDesigner as for working of the scripted
object data from FDOnAir are needed.
To preview your TSF_Age scripted object, start the schedule
execution in FDOnAir. You can preview your project using
FDPreview or SLTitlePreview.
For information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_AdvMix, TSF_AdvMixPS, TSF_AdvMixPS2 – sequences of different
kinds of messages: images, video clips, crawl lines with pauses
1. Purpose and features
The TSF_AdvMix, TSF_AdvMixPS, TSF_AdvMixPS2 scripted objects
are designed for the sequential display of different kind of
messages (1) in the same area of the screen: images, video clips,
crawl lines. When displaying a crawl line, a part of the text can
be paused (for example, a phone number, see next section for
more information).

1

The scripted objects of this group have similar purposes and
operating procedures, and differ only in the different options
of displaying a crawl line (see comparative table below): the
paused text parameters and the presence of a background.
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Name of
scripted object

Paused text. Parameters
Position

Display appearance

Background
Display duration

and dis appearance

TSF_AdvMix

Determined automatically
and depends on the
position of the crawl line
itself, can not be edited:
crawls out in the same line
as the main text and stops
in the center of the crawl
line.

Crawls from right Set by the user. No
to left in the same
line as the main
text. Reaches the
center of the crawl
line
and
stops
for the set time.
Disappears
left.

TSF_AdvMixPS

Determined automatically
and depends on the
position of the crawl line
itself, can not be edited:
a separate line above the
main text of the crawl line.

Crawls from right
to left and starts
at the same time
as the main text.
Reaches the left
border and stops.
Disappears left at
the same time as
the main text.

Determined
No
automatically:
the
display
duration
is
the same as
the
display
duration of the
main text.

TSF_AdvMixPS2

Arbitrary, set by the user.

Set by the user.

Determined
Yes
automatically:
the
display
duration
is
the same as
the
display
duration of the
main text.

2. Display of a crawl line with paused text
2.1. General rules
When using the TSF_AdvMix, TSF_AdvMixPS, TSF_AdvMixPS2
scripted objects each message in the crawl line can consist of
two parts: the running text and the paused text. The scripted
objects differ in the options of displaying the paused text (more
information in next paragraphs).
The running and paused text can have different format styles.
The style collection file (*.efc) and the style numbers for both
parts are set when configuring the scripted object settings.
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2.2. TSF_AdvMix
When using the TSF_AdvMix scripted object the following rules
on the display of the paused text apply:
1. The paused text crawls in the same line as the running
text (1).
2. The paused text pauses in the center of the line.
1

Ad text
(displayed without stopping)

Text with a phone number
(stopped text)

2.3. TSF_AdvMixPS
When using the TSF_AdvMixPS scripted object the following
rules on the display of the paused text apply:
1. The paused text crawls in a separate (1) line above the
running text (2).
2. The position of the line is set automatically: directly above
the main text of the crawl line.
1
2

3. Both lines start at the same time and crawl from right to
left.
4. The phone number, after crawling all the way across the
Phone title element, reaches the left border (3) and stops.
3
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2.4. TSF_AdvMixPS2
When using the TSF_AdvMixPS2 scripted object the following
rules on the display of the paused text apply:
1. The paused text crawls in a separate line (1) the placement
of which is set by the user.

1

2. The appearance and disappearance of the text is determined
by the user by configuring the settings of the Phone0 and
Phone1 title elements.
3. The display duration of the paused text is the same as the
display duration of the running text.
Note:

The Phone0 and Phone1 title elements are designed to display the
paused text. When displaying crawl lines the script loads the rest
of the text first into one element, then the other, therefore if the
elements have different settings for the text position and appearance/
disappearance, then when the display of the text will vary in between
the two.

3. Task file
3.1. Contents
A task for a TSF_AdvMix, TSF_AdvMixPS, TSF_AdvMixPS2 script is
a text file (*.txt). The file can contain lines of two different types:
1. Message text (1) – for text message display.
2. Paths to images and video clips (2) – for displaying images
or video clips in the crawl line.
The image shows an example task file opened in the Notepad
editor.

1

2
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3.2. Text messages
Lines with message text for the crawl lines must have the
following format:
Text_1 Separator Text_2

where:

●● Text_1 – running text;
●● Separator – divider symbol, set in the script settings
(Separators parameter);
●● Text_2 – paused text.

Line example:
Selling car | Phone: 123-45-67
Text_1

Separator

Text_2

The lines can contain formatting tags. For more information
on using tags see the «FDTitle Designer. Title project editor»
User’s Guide.
It is possible to include a substitution function in the message
texts, see current User’s Guide, chapter «General information»,
section «Substitution file».

3.3. Images and video clips
To display images and video clips, a line containing a path to
the necessary file should be added to the task file: either the full
path or a relative path from the folder where the script task file
is saved.

4. Object’s title elements
4.1. Element list
The table lists the title elements contained in the title objects
with the TSF_AdvMix, TSF_AdvMixPS, TSF_AdvMixPS2 scripts as
well as their type and their purpose.
Name

Type

Purpose

Main

Caption

Auxiliary element, used by the script object during its work

Movie0,
Movie1

AnimLogo Display of video clips

Crawl0,
Crawl1

Caption

Display of running text

Phone0,
Phone1

Caption

Display of paused text

Pict0,
Pict1

Caption

Display of images

Backgr

AnimLogo Contained only in the TSF_AdvMixPS2 script. Display of a

background for the crawl line: an image or video clip
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Note:

88

«Paired» title elements such as Movie0 and Movie1 or Crawl0 and
Crawl1 generally have the same settings.

Important: It is impossible to change the types and names of the title

elements contained within the scripted object. It is possible to
change the name of the title object with the script.

4.2. Size and placement

The size and placement of the Main title element determine the
size and placement of the rest of the title object elements: when
starting the script the size and placement of all of title elements
(TSF_AdvMix) or all of the title elements except Phone0 and
Phone1 (TSF_AdvMixPS, TSF_AdvMixPS2) are automatically set as
identical to the Main title element (see section «Configuring the
size and placement of titles (Main element))».

5. Operating procedure
5.1. Preliminary preparation
1. Prepare a task file for the script.
2. Prepare a file with text styles (*.efc) for the crawl line. For
a description of how to create a style collection file, see the
«ForwardTitling. Graphic editor» User’s Guide.

5.2. Opening and configuring
1. In the FDTitleDesigner program create a new or open
an existing title project to which the title object with the
TSF_AdvMix/TSF_AdvMixPS/TSF_AdvMixPS2 script needs to be
added.
2. In the File (1) menu select Import Object Template...(2) or use
the corresponding command of the context menu of the Object tree panel (3).
1

2

3
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3. In the opened window open the folder containing the
template library TSF and select the *.SLTitleTmpl file the
name of which coincides with the necessary scripted
object: TSF_AdvMix, TSF_AdvMixPS, or TSF_AdvMixPS2. Press
Open (4).

4

4. The title object with the script will be added to the title
project. All of the title elements will have the size and
placement set in the template.
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Important: It is impossible to change the types and names of the title

elements contained within the scripted object. It is possible to
change the name of the title object with the script.

5. To start configuring the script parameters left click the title
object with the script (2) in the Object Tree window (1).
1

2

6. In the TaskName (3) field set the full path to the task file.
7. If the ScriptProperties list is minimized, expand it (4).
Configure the general parameters of the script.

3
4
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5.3. Configuring script parameters
The parameters of the TSF_AdvMix, TSF_AdvMixPS,
TSF_AdvMixPS2 scripted objects are practically identical (in the
list below the parameters that are unique to a single script are
marked as such):
1. Separators – a divider used in the task file (divides the
running and paused text messages) and in the substitution
file (divides the text to be replaced and the replacement).
2. Phone stay time (only for TSF_AdvMix) – the display duration
(in seconds) of the paused text (for example, a phone
number).

3. Picture duration – the display duration (in seconds) of images.
4. Picture fade in/out – the duration of the appearance/
disappearance of images (smooth transition in seconds).
5. Crawl speed – speed of the crawl line (pixels per frame).
6. Background – (only for TSF_AdvMixPS2) – full path to the
graphical file with the background.
7. Substitution file – full path to the substitution file (see the
«General information» chapter, section «Substitution file»).
8

Styles file – full path to the style file for the crawl line.

9. Crawl style – index of the style used for the running text.
10. Phone style – index of the style used for the paused text.
11. Loop – loop the execution of the task file:
●● True – yes;
●● False – no.
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5.4. Configuring the size and placement of the titles (Main element)
In order to set the display area of the titles displayed using
scripted objects it is necessary to set the size and placement of
the Main title element.
In the Object tree select the Main title element by left clicking on
it (1).
Set the necessary values of the position and size of the Main title
element using one of the following methods:
●● by changing the values of the Location (2) and Size (3)
parameters in the Properties window;
●● by changing the placement and size of the element on
the work field of the project (4).

1
2

3

4

When starting the script the size and placement of the object
elements will be automatically set according to the size and
placement of the Main title element in the following ways:
1. TSF_AdvMix scripted object: the size and placement of all of
the elements will be the same as the Main title element.
2. TSF_AdvMixPS scripted object: same, excluding a couple
of elements used to display the paused text – Phone0 and
Phone1. The lower border of the Phone0 and Phone1 elements
will be automatically be identical to the upper border of the
Main title element.
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3. TSF_AdvMixPS2 script-object: same, excluding a couple of
elements used to display the paused text – Phone0 and
Phone1. Their size and placement are arbitrary and can be
set by the user, and are not automatically set.
To set the necessary position and size, select the Phone0 (1)
element in the Object tree.

1

5.5. Configuring parameters of message display
88

Important: 1. All of the main parameters of the crawl line (task file, style

file, etc.) are set in the general parameter group of the scripted
object (see paragraph 5.3).
2. The position and size of the titles is set when configuring the
Main element parameters (see paragraph 5.4).
For title elements used to display messages the only available
parameters for configuring are specific settings that aren’t set
in the general parameters or in the Main element parameters,
for example Alignment and Stretch. The names of the parameters
available for editing are highlighted with a dark color.

„„

Tip: For all paired elements (Movie0 and Movie1, Pict0 and Pict1,

Crawl0 and Crawl1, Phone0 and Phone1) it is highly recommended

to have identical settings.

57

If necessary, configure other title elements:
1. Movie0 and Movie1. Used for displaying video.
2. Pict0 and Pict1. Used for displaying images.
3. Crawl0 and Crawl1. Used for displaying a crawl line. These
elements are used to display the running text of the crawl
line.
4. Backgr (only for the TSF_AdvMixPS2 scripted object). Used to
display a background for crawl line, if necessary.

5.6. Finishing configuration and Preview
1. Press Save project (1).
2. Press Start Preview (2) to start a preview of the project.

1

2
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TSF_Announce: Displaying of announce
1. Purpose
The TSF_Announce scripted title object is intended for displaying
of announcement, i.e. information on the next program; it can
also be used for displaying of information on age restrictions.

The TSF_Announce scripted title object displays data during
execution of video displaying commands (movie) or videos from
the video input (videoN) in FDOnAir schedule.
The data is played back once during execution of one schedule
command. Moment when the announcement to be displayed is
determined some time before the start or end of execution of
next command. Duration of displaying is to be specified by user.
Announce can be presented as:
●● image;
●● video;
●● text.
When working, the TSF_Announce scripted title object uses
information received from FDOnAir: name of the video file (if
the command is movie) being played back and its duration.
Announce is displayed during execution of the commands for
which the scripted titled object has tasks: records of a task file
or in FDOnAir schedule comments.

2. Data sources for the scripted object
2.1. General information
The TSF_Announce scripted title object can use the following
data sources:
●● task file;
●● FDOnAir schedule comments.
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Important: When working, the scripted object can use only one data source:
either schedule comments or task file. It is impossible to use at
the same time schedule comments and task file.
The way of recording of the data in the source depends on the
Task type parameter of the scripted object (1).

1

The Task type parameter can have the following values:
●● 1 – text. Set this value if using the scripted object you
need only a text to be displayed;
●● 2 – image. Set this value if using the scripted object
you need only an image to be displayed. In this case,
in the task records the image file names are to be
specified without extension. E.g. for displaying of
data from the file named picture.jpg specify in the task
record its name without extension, i.e. picture (to find
some task examples see p. 2.2 and 2.3);
●● 3 – video. Set this value if using the scripted object you
need only a video to be displayed. In this case, in the
task records the video file names are to be specified
without extension (to find some task examples see p.
2.2 and 2.3);
●● 0 – in this case the scripted object determines the task
type automatically. If a task for the scripted object
contains records for displaying of data from image of
video files, in the task records the image file names
are to be specified with extension. Set 0 if you need to
display using the scripted object data from sources of
different types: image, video files or text.
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2.2. Task file
A task file for the TSF_Announce scripted title object is a text file
with *.txt extension.
The task file contains a list of videos and tasks to be loaded to
the TSF_Announce scripted title object when playing back these
videos. Each record has the following structure:
Video_file_name Separator Task_to_be_shown_as_announce

where:

●● Video_file_name denotes the absolute or relative path to
the video file for which the task in the current line is
intended. Relative path is to be specified relatively to
location of the task file for the scripted object;
●● Separator is a character specified when configuring the
scripted object in FDTitleDesigner as Separators (the
«|» character is set by default);
●● Task_to_be_shown_as_announce denotes the task to be
shown as announce. How to compose the task depends
on what you set as value of the Task type parameter
and data of what kind you need to load to the scripted
object:
●● for image specify the absolute or relative path
to the image file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
Example:
a) the Task type parameter value is 0
D:\Announce\autumn.avi | D:\Announce\winter.png
Full path to the file during playing back
of which the announce are to be shown

Separator

Full path to the announce image file

b) the Task type parameter value is 2
D:\Announce\autumn.avi | D:\Announce\winter

c) if the task file, the background video file and
image file are in the same folder and the Task
type parameter value is 2, the line will have the
following structure:
autumn.avi | winter
Relative path to the file during playing
back of which the announce are to be
shown

Separator

Relative path to the winter.png file; the file
name is specified without its extension,
because the Task type parameter value is 2

●● for video specify the absolute or relative path
to the video file. Relative path is to be specified
relatively to location of the task file for the scripted
object.
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Example:
a) the Task type parameter value is 0
D:\Announce\autumn.avi | D:\Announce\winter.avi
Full path to the file during playing back
of which the announce are to be shown

Separator

Full path to the announce video file

b) the Task type parameter value is 3
D:\Announce\autumn.avi | D:\Announce\winter

c) if the task file, the background video file and
video file to be shown in titles are in the same
folder and the Task type parameter value is 3, the
line will have the following structure:
autumn.avi | winter
Relative path to the file during playing
back of which the announce are to be
shown

Separator

Relative path to the winter.avi file; the file
name is specified without its extension,
because the Task type parameter value is 3

●● for text specify the text you want to be shown
as announce. If you need to display a text that
contains several lines put the separator in the
place you need to feed the line. If you put a space
character between the separator and the text line,
when displaying, the text will be started from the
space character.
Example:
Separator

D:\Announce\spring.avi |Next | Summer...
Full path to the file during playing back
of which the announce are to be shown

Text line 1

Text line 2

Text lines can contain formatting tags. For more
information on using formatting tags see the «Tags
of formatting» paragraph in the «Types of Title
Elements» section of the «FDTitleDesigner. Title
Project Editor» User’s Guide.
Example of a line containing formatting tags:
D:\spring.avi |<St1>Next: | <St4>Summer is...

In this example, using the <St1> and <St4> tags, we
specified text design styles (as a source of styles
collection the file specified in the scripted object
settings is used).
The order of lines in the file is arbitrary. One task file can
contain information on titling of several videos, regardless of
their presence in FDOnAir schedule.
The picture below presents an example of a task file opened in
Notepad.
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2.3. FDOnAir schedule comments
In the schedule the comment line containing a task for the
TSF_Announce scripted object is to be placed immediately before
the command for displaying the video, during playing back of
which the scripted object has to execute the task specified in the
line.
The text of comment should have the following structure:
Comments_label Space Task_to_be_shown_as announce

where:

●● Comments_label denotes a word or a character specified
by user when configuring the scripted object in
FDTitleDesigner in the Comment tag parameter.
In the examples below as a comment tag the «#»
character is used.
●● Space denotes space character.
●● Task_to_be_shown_as_announce denotes the task to be
shown as announce. How to compose the task depends
on what you set as value of the Task type parameter
(see p. 2.1) and data of what kind you need to load to
the scripted object:
●● for image specify the absolute or relative path
to the image file. Relative path is to be specified
relatively to location of the task file for the scripted
object. To find how to use relative paths to the files
in the comments, see p. 2.4. «Using of the relative
paths in the comments».
Example:
a) the Task type parameter value is 0
# D:\Announce\winter.png
Comment
tag

Space
character

Full path to the file, the Task type
parameter value is 0

b) the Task type parameter value is 2
# winter
Comment
tag

Space
Relative path to the winter.png file; the file
character name is specified without its extension, because
the Task type parameter value is 2

●● for video specify the absolute or relative path
to the video file. Relative path is to be specified
relatively to location of the task file for the scripted
object. If it is necessary to specify the extension of
the file or not, depends on the value of the Task type
parameter.
Example:
# D:\TSF_Announce\spring.avi;
●● for text specify the text you want to be shown as
announce.
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If you need to display a text that contains several
lines put the separator in the place you need to
feed the line.
Example:
Comment tag

Text line 1

Text line 2

announce Next: |Gone with the wind
Space character Separator

Text lines can contain formatting tags. For more
information on using formatting tags see the «Tags
of formatting» paragraph in the «Types of Title
Elements» section of the FDTitleDesigner. Title
Project Editor User’s Guide.
The picture below presents an example of a schedule containing
comments intended for using as the task for the TSF_Announce
scripted title object.

2.4. Using of relative paths in the comments
To use relative paths to the files in the comments do the
following:
●● create a new *.txt file;
●● save the created file to the folder with the files you
want to use in your titles;
●● in the FDTitleDesigner specify the created file as the
value of the TaskName parameter (1); as the value of
the Use Comments (2) parameter set True;
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●● in the comments specify the relative paths to the
files intended to be loaded to the title elements of the
TSF_Announce scripted object relatively to the location
of the task file.

3. Title elements of the object
3.1. List of the elements
In the table below the title elements contained in the
TSF_Announce scripted title object are listed, specifying their
type and purpose.

Name

Type

Purpose

Main

Caption

Auxiliary element used by the script object during its work

Backgr

AnimLogo Used to display a background image

Movie

AnimLogo Used to playback video files. Specify the size and location of this

Descr

Caption

title element if your task file contains records to display video files
Used to display text or images. Specify the size and location of this
title element if your task file contains records to display graphic
files or text

3.2. Size and location
User can change size and location of any title element of the
TSF_Announce scripted title object.
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4. Working with the scripted object
1. Preparation for work:
Prepare the following files before starting to configure the
TSF_Announce scripted object
●● task file for the scripted object, if used (see p.2.1 «Task
file»);
●● if your task file contains records to display text,
prepare a style collection file for text design (*.efc). For
more information on how to create a style collection
file see «ForwardTitling. Graphic Editor» User’s Guide;
●● a background image file, if used.
2. In FDTitleDesigner create a title project or load one created
before where you need to add a scripted title object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) right-clicking on the Object Tree
panel and select the Import Object Template... command (4).

1

3

2

4

4. In the Import Object Template... window that opens select the
TSF_Announce.SLTitleTmpl file (5) and click Open (6).

5

6
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5. The TSF_Announce scripted title object will be loaded to your
title project:
●● in the object tree the added TSF_Announce object (7)
and its elements are displayed;
●● in the working area of the project title elements of
the TSF_Announce scripted object are displayed. After
the loading all title elements have the same size and
location (8) specified in the template.

7

8

88

Important: Do not change the composition, type and name of title elements
of the scripted object. But you can change the name of the
scripted object.

6. To start setting parameters of the scripted object, in the
Object Tree window (1) click on the name of the TSF_Announce
scripted object (2).
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7. If you use a task file as a data source for your scripted
object, specify the name of your task file in the TaskName
line (3).
8. If the ScriptProperties list (4) is minimized expand it clicking
on the icon (5).

5

4

6

9. Specify values of the script parameters (6):
●● Comments label: a word or a character from which
schedule comments should be started, intended for the
scripted object being set as a data source. Specify the
comment tag if you use schedule comments as a data
source for your scripted object.
●● Separator: the separator character used in your data
source (task file or schedule comments);
●● Use comments: denotes the data source for the scripted
object:
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●● False, if you want to use task file as a data source
for the scripted object; schedule comments are not
used;
●● True, if you want to use schedule comments as a
data source for the scripted object; task file is not
used;
●● From Start denotes relative to what the Delay
parameter’s value is set:
●● True, if it is set relative to the start of the playing
back of the video;
●● False, if it is set relative to the end of the playing
back of the video;
●● Duration: duration of showing of the announce
(seconds). If you need to display a video file using
the title object, the duration of showing is set
automatically as equal to the duration of the video file.
●● Delay: Time from the start or end of the video in
FDOnAir, during playing back of which the announce
is to be displayed (seconds);
●● Fade in/out: Time of appearing/disappearing of titles
(fade in/out; seconds);
●● Background: a full path to the background image file
(optional parameter);
●● Styles file: a full path to the style collection file (*.efc).
Specify this parameter value if your task file contains
records for displaying text data;
●● Description style: index of the style in the style
collection file used for design of the text of the titles
(enumeration of styles starts from 0) (optional
parameter).
Note:

For design of different parts of the text with different styles you can
use formatting tags. See an example in p. 2 «Data sources for the
scripted object».
For more information on properties of title elements of different types
see the «Types of Title Elements» section on the «FDTitleDesigner.
Title Project Editor» User’s Guide.

●● Task type: type of the task to be displayed in the titles.
For more information see p. 2.1 «General Information»
of the p. 2 «Data sources for the scripted object».
10. If your task file contains records for displaying videos, select
the Movie title element in the Object Tree window and set it.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section on the
«FDTitleDesigner. Title Project Editor» User’s Guide.
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11. If your task file contains records for displaying image files
or text, select the Descr parameter in the Object Tree window
and set it.

88

Important: Specify the styles collection file and style index that you want

to be used for design of your text in parameters of the scripted
object.

12. If you need to display background image, select the Backgr
parameter in the Object Tree window and set it.
13. Save your project.

5. Preview
To preview your TSF_Announce scripted object, start the
schedule execution in FDOnAir. You can preview your project
using FDPreview or SLTitlePreview.
For information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_IU: generating of images with information
received from different sources
(analogue of FDImageUpdater)
1. Purpose
The TSF_IU scripted object works in the same way as the
FDImageUpdater program and is intended for displaying
images with information received from different sources:
●● text file;
●● website;
●● time source:
●● integrated computer clock (PC system time);
●● SLTimeServer;
●● temperature sensor:
●● IRT 5920;
●● Tundra 73;
●● Stream Labs USB_MS_RS485;
●● PMM-4095;
●● weather stations:
●● HeavyWeather (models: WS2308, WS2310,
WS2315; WS3610);
●● Oregon Scientific (models: WMR100, WMR200);
●● Davis Instruments (Vantage Pro2).
16:35

A task for the scripted object is a project created in
FDImageUpdater. During execution of the scripted object you
don’t need to launch FDImageUpdater.
In the TSF_IU scripted object you can specify a background
image.
Adding several TSF_IU scripted objects is similar to launching
several instances of the FDImageUpdater program.
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To load a TSF_IU scripted object in your title project use a
TSF_IU.SLTitleTmpl template file.

2. Data sources for the scripted object
As a data source the scripted object uses the project file created
in FDImageUpdater. Such files have the *.s4i extension.
Find information on creation of projects in the FDImageUpdater
program in the «FDImageUpdater. Program for Organizing
Dynamic Data Update in Titles» User’s Guide.

3. Title elements of the object
3.1. List of the elements
In the table below the title elements contained in the TSF_IU
scripted title object are listed, specifying their type and purpose.
Name

Type

Purpose

Picture

Picture

Used to display images generated during the work of the scripted
object

Backgr

Picture

Used to display a background image

3.2. Size and location
User can change size and location of any title element of the
TSF_IU scripted title object.

4. Working with the scripted object
1. Preparation for work: using FDImageUpdater create a
project that will be used as a task file for the TSF_IU scripted
object and check its work.
2. In FDTitleDesigner create a title project or load one created
before where you need to add a TSF_IU scripted title object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) by right clicking on the Object Tree
panel and select the Import Object Template... command (4).
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4. In the Import Object Template... window that opens select the
TSF_IU.SLTitleTmpl file (5) and click Open (6).

5

6

5. The TSF_IU scripted title object will be loaded to your title
project:
●● in the object tree the added TSF_IU object (7) and its
elements are displayed;
●● in the working area of the project the Picture title
element contained in the TSF_IU scripted object is
displayed.
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Important: You can not change the composition, type and name of title

elements of the scripted object. But you can change the name of
the scripted object.

6. In the Object Tree window (1) click on the name of the TSF_IU
scripted object (2).
1
2

3

7. In the TaskName line (3) specify the name of your task file
prepared in FDImageUpdater.
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8. In the Object Tree window select the Picture title element (1)
and configure it.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section on the
«FDTitleDesigner. Title Project Editor» User’s Guide.

9. If you need to display background image, configure
the Backgr title element: specify its size, location and if
necessary set other parameters available for setting.
10. Save your project.

6. Preview
You can preview your project containing the TSF_IU scripted
object in the preview window of FDTitleDesigner.
For information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_MovieList: a scripted wrapper for the MovieList title element
1. Purpose

„„

Tip: We recommend you to read the description of the MovieList title
element in the «FDTitle Designer Title Project Editor» User’s
Guide.

The TSF_MovieList scripted object works in the same way as the
MovieList title element, but the scripted object has the following
additional features:
●● you can display a background image that will be
displayed during pauses in the task (see p. 3.3
«Particularities of playing back»);
●● task item that can’t be played back entirely can be
played back in part.
Note:

the MovieList title element does not play back the task item if it has
not enough time to play it back entirely.

If the work of the scripted object was stopped by a FDOnAir
schedule command, during the next launch the scripted object
will execute the task item following the item has been executed
during the last session.

2. Task file
A task file for the TSF_MovieList scripted object is a text file
with the *.SLMovieList extension. The file contains XML tags
that determine the order of playing back of videos, images and
pauses to be displayed during the work of the scripted object.
Files of that type are used as task files for the MovieList title
elements. The principle of composing the task file for the
TSF_MovieList scripted object is the same as for the MovieList title
element.
For automation of creating *.SLMovieList files the
FDMovieListEditor program is intended.
For more information on how to use FDMovieListEditor see
the «FDMovieListEditor – Task editor for the MovieList title
element» User’s Guide.
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b

The pictures below present the same task file opened in the
FDMovieListEditor window (a) and in Notepad (b).

3. Title elements of the object
3.1. List of the elements
In the table below the title elements contained in the TSF_MovieList scripted title object are listed, specifying their type and
purpose.
Name

Type

Purpose

Main

Caption

Auxiliary element used by the script object during its work

Backgr

AnimLogo Used to display a background image

MovieList

MovieList

Used to display elements of an advertisement block: images, video
clips, pauses
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3.2. Size and location
User can change size and location of any title element of the
TSF_MovieList scripted title object.

3.3. Particularities of playing back
A task for the Backgr title element is to be specified only of you
need a background image to be displayed.
During the work with the TSF_MovieList scripted title object the
Backgr title element is displayed constantly.
The MovieList title element is displayed over the Backgr element.
If the Backgr title element is located within the limits of the
MovieList element’s location, so when displaying videos or
pictures in the MovieList title element, the Backgr title element is
invisible.
The Backgr title element is visible:
●● if the Backgr title element is located within the limits
of the MovieList element’s placement: when pause tasks
are executed in the the MovieList title element;
●● if the element is located outside the limits of the
MovieList element’s placement: all the time of the
TSF_MovieList scripted title object’s work.

4. Working with the scripted object
1. Preparation for work
●● prepare your task file for the TSF_MovieList
scripted object using FDMovieListEditor. For more
information on how to use FDMovieListEditor see the
«FDMovieListEditor – Task editor for the MovieList
title element» User’s Guide.
●● if you need to display a background, prepare a
corresponding image file.
2. In FDTitleDesigner create a title project or load one created
before where you need to add the scripted title object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) clicking on the FDTitleDesigner
Object Tree panel and select the Import Object Template...
command (4).
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4. In the Import Object Template... window that opens select the
TSF_MovieList.SLTitleTmpl file (5) and click Open (6).

5

6

5. The TSF_MovieList scripted title object will be loaded to your
title project:
●● in the object tree the added TSF_MovieList object (7)
and its elements are displayed;
●● in the working area of the project title elements of
the TSF_MovieList scripted object are displayed. After
the loading all title elements have the same size and
location (8) specified in the template.
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Important: You can not change the composition, type and name of title

elements of the scripted object. But you can change the name of
the scripted object.

6. To start setting parameters of the scripted object, in the
Object Tree window (1) click on the name of the TSF_MovieList
scripted object (2).
1
2

3

7. In the Properties window in the TaskName line (3) specify the
name of your task file.
8. If the ScriptProperties list (4) is minimized expand it clicking
on the icon (5).
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9. Specify values of the script parameters (6):
●● Abort last – to allow the program to play back partially
the task point that cannot be played back entirely
because of lack of time.
●● False: do not allow. The task point will not be
played back at all.
●● True: allow. Duration of playing back of the last
item will be reduced.
●● Background: a full path to the background image file
(optional parameter);
10. In the Object Tree window select the MovieList title element
and configure it.
11. If you need to change the size, location or other parameters
of the background image, select the Backgr title element in
the Object Tree window and configure it.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section in the
«FDTitleDesigner. Title Project Editor» User’s Guide.

12. Save your project.

5. Preview
You can preview your project containing the TSF_MovieList
scripted object in the preview window of FDTitleDesigner.
For information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_CaptionPro: displaying text ads and images
1. Purpose

„„

Tip: We recommend you to read the description of the Caption title
element in the «FDTitleDesigner Title Project Editor» User’s
Guide.

Note:

The Caption title element is intended to display in the specified area of
the screen a text or image that appears/disappears.
A task for the Caption title element can be:
– a graphics file in one of the following formats: TGA, BMP, DIB,
PNG, JPG;
– a text file in the TXT format. The text of one file is considered as one
message, so the entire contents of the task file will be displayed on the
screen as one block.

How the scripted title element works
TSF_CaptionPro works in the same way as the Caption title

element, but the scripted object has the following additional
features:
●● one task file can contain several announcements of
different types (text or image): the TSF_CaptionPro
scripted object displays them consecutively;
●● using this scripted object, you can display a
background image.
If the work of the scripted object was stopped by a FDOnAir
schedule command, during the next launch the scripted object
will execute the task item following the item has been executed
during the last session.

2. Task file
A task file for the TSF_CaptionPro scripted title object is a text
file with *.txt or *.spt extension.
A task file with the *.txt extension can contain only tasks
for displaying text announcements. The text of separate
announcements must be recorded in separate lines. The file can
contain formatting tags.
The picture below presents an example of a task file opened in
Notepad.
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„„

Tip: To break a text of a long announcement to several lines, use

the <NL> formatting tag. For more information on using tags
see the «Tags of Formatting» subsection in the «Types of Title
Elements» section in the «FDTitleDesigner. Title Project Editor»
User’s Guide.
A task file with the *.spt extension contains commands for
displaying text and images:
●● a command for displaying announcement as image has
the following format:
targa Path_to_file, where:
●● targa is the key word of the command;
●● Path_to_file denotes a full or relative path to the
image file with the announcement.
●● a command for displaying announcement as text line
has the following format:
text#N text_line, where:
●● text is the key word of the command;
●● # is a mandatory character; do not separate it with
a space character from text or N;
●● N denotes the sequence number of the style in the
collection you want to apply for the text styling;
●● text_line denotes the text of one announcement.
For more information on SPT file see the item 4 «Task: Text File
with Commands for Displaying Ads» of the «RollCrawl» section
on the «FDTitleDesigner. Title Project Editor» User’s Guide.
The picture below presents an example of a *.spt task file opened
in Notepad.
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3. Title elements of the object
3.1. List of the elements
In the table below the title elements contained in the
TSF_CaptionPro scripted title object are listed, specifying their
type and purpose.

Name

Type

Purpose

Main

Caption

Auxiliary element used by the script object during its work

Backgr

AnimLogo

Used to display a background image

Text0, Text1

Caption

Used to display announce text or images

3.2. Size and location
When starting the execution of the scripted object, the size and
location of the Text1 title element are set automatically as equal
to the size and location of the Text0 title element.

4. Working with the scripted object
1. Preparation for work:
●● prepare your task file for the TSF_CaptionPro scripted
object;
●● if you need to display a background, prepare a
corresponding image file.
2. In FDTitleDesigner create a title project or load one created
before where you need to add a scripted title object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) right-clicking on the Object Tree
panel and select the Import Object Template... command (4).
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1

3

2

4

4. In the Import Object Template... window that opens select the
TSF_CaptionPro.SLTitleTmpl file (5) and click Open (6).

5

6

5. The TSF_CaptionPro scripted title object will be loaded to
your title project:
●● in the object tree the added TSF_CaptionPro object (7)
and its elements are displayed;
●● in the working area of the project title elements of the
TSF_CaptionPro scripted object are displayed. After the
loading all title elements have the size and location (8)
specified in the template.
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7

8
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Important: Do not change the composition, type and name of title elements
of the scripted object.
But you can change the name of the scripted object.

6. To start setting parameters of the scripted object, in the
Object Tree window (1) click on the name of the
TSF_CaptionPro scripted object (2).
1
2

3

7. In the TaskName line (3) specify the name of your task file.
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8. If the ScriptProperties list (4) is minimized expand it clicking
on the icon (5).

5

4
6

9. Specify values of the script parameters (6):
●● Pause – a pause between announcements;
●● Loop: to replay back the announcements from task file
after the playing back of the list:
●● True: to replay;
●● False: not to replay;
●● Background: a full path to the background image file
(optional parameter);
●● Stop mode: how the scripted object will act when the
schedule execution is stopped:
●● before script stops: if there is not enough time to
play back the scheduled announcement entirely
before the execution of the stopping command, the
program will not start to play it back.
●● at script stop: to break the announcement playback
at the moment of stopping of the scripted object;
●● after script stops: if there is not enough time to
play back the scheduled announcement entirely
before the execution of the stopping command, the
program will not stop the scripted object before
playing back the announcement entirely.
10. In the Object Tree window, select the Text0 (7) title element
and configure it: its size, location, settings for appearing/
disappearing and announcement displaying, etc.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section on the
«FDTitleDesigner. Title Project Editor» User`s Guide.
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7

When the Text0 title element is configured, click Start preview,
then wait a while and click Stop preview: the same settings
will automatically be set to the Text1 title element.
11. If you need to display background image, select the Backgr
title element in the Object Tree window and configure it.
12. Save your project.

5. Preview
You can preview your project cont aining the TSF_CaptionPro
scripted object in the preview window of FDTitleDesigner.
For information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_AdCountDown: displaying of countdown timer until the end of the
advertisement
1. Purpose
The TSF_AdCountDown scripted title object is intended for
displaying countdown timer until the end of the advertisement.
The timer is displayed on the background image specified by
user.

To use this scripted object, add to your FDOnAir schedule
special marks of the start and end of ad blocks (see the
paragraph 2. «Scheduling details»).
The duration of the displayed countdown is specified by user
and equal for all ad blocks. The TSF_AdCountDown scripted
object manages automatically the countdown launching and
stopping.
The TSF_AdCountDown scripted object contains an option that
allows it to ignore commands that deactivate titles before the
start of advertisement playing back.
To display the countdown the scripted object uses the Clock2 or
Clock3 title element by user’s choice.
Note:

To use this scripted title object, make sure that you use at least
version 5.7.0 of ForwardT Software.
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2. Scheduling details
When using the TSF_AdCountDown scripted object, add to your
schedule special mark commands denoting the start and the
end of ad blocks you want to be counted down.

The marks allow FDOnAir to count the duration of the ad
block and to transfer this information to the TSF_AdCountDown
scripted object.
To add such mark commands to your schedule, do the following:
1. In the main FDOnAir window open the Custom commands
tab, clicking on the button (1).

2

1

3

2. Add and configure the Start mark command. To do so:
1. Click New mark start command (2). The new command will
appear in your command list (3).
The command has the following format:
markstart {mark} 0 Command_comment,

where:

●●
– is the mark symbol;
●● markstart – is the command keyword;
●● {mark} – denotes the mark name. Make sure to specify
the same mark name as you specified in the Mark name
property when configuring the scripted object;
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●● 0 – denotes the duration of the command execution
(the 0 value is set automatically and cannot be
changed);
●● Command_comment – denotes a text containing a
comment concerning the using of the command. When
adding the command to the schedule the comment will
be displayed in the Name column.
2. If necessary, change the command comment. To do so,
place the cursor to the line (4) and change the text.
3. If necessary, change the mark name. To do so, place the
cursor to the line (5) and change the text.
4

5
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Important: Make sure to specify the same mark name as you specified in

the Mark name property when configuring the TSF_AdCountDown
scripted object in FDTitleDesigner (for more information, see
«4. Working with the scripted object»).
3. Add and configure the Stop mark command. To do so:
1. Click New mark stop command (6). The new command will
appear in your command list (7).
6

7

The command has the following format:
markstop {mark} 0 Command_comment,

where:

●●
– is the mark symbol;
●● markstop – is the command keyword;
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●● {mark} – denotes the mark name. Make sure to specify
the same mark name as you specified in the Mark name
property when configuring the scripted object;
●● 0 – denotes the duration of the command execution
(the 0 value is set automatically and cannot be
changed);
●● Command_comment – denotes a text containing a
comment concerning the using of the command. When
adding the command to the schedule the comment will
be displayed in the Name column.
2. If necessary, change the command comment. To do so,
place the cursor to the line (8) and change the text.
3. If necessary, change the mark name. To do so, place the
cursor to the line (9) and change the text.

8

9
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Important: Make sure to specify the same mark name in the Start mark and

Stop mark commands as you specified in the Mark name property
when configuring the TSF_AdCountDown scripted object.

4. Add the Start mark and Stop mark in your schedule for each
ad block for which you want the countdown timer to be
displayed:
●● the Start mark command (10) should be placed before
the first execution command in the ad block;
●● the Stop mark command (11) should be placed after the
last execution command in the ad block.
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10

11

To add a Start mark/Stop mark command to your schedule, do the
following:
1. Place the position pointer to the necessary line.
2. On the Custom commands tab, double click on the
corresponding command.

3. Title elements of the object
In the table below the title elements contained in the
TSF_AdCountDown scripted title object are listed, indicating their
type and purpose.
Name

Type

Purpose

Main

Caption

Auxiliary element, used by the script object during its work

Backgr

AnimLogo Displaying of the background image

Clock2

Clock2

Displaying of the countdown timer

Clock3

ClocK3

Displaying of the countdown timer

4. Working with the scripted object
1. Preparation for work:
●● If you need a background to be displayed, prepare the
background image file;
●● If you want the Clock2 title element to be used for the
countdown, prepare a task file for the title element (for
more information on how to prepare a task file, see the
«SLClockDesigner. Task Editor for the Clock2 Title
Element» User’s Guide).
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„„

Tip: Find the description of the Clock2 and Clock3 title elements in
the «FDTitle Designer. Title Project Editor» User’s Guide.

2. In FDTitleDesigner create a title project or load one created
before where you need to add a TSF_AdCountDown scripted
title object.
3. To load the scripted title object to your project, select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (4) clicking on the FDTitleDesigner
Object Tree panel (3) and select the Import Object Template...
command.
2
4

8
1
9

3

4. In the Import Object fromTemplate window that opens select the
TSF_AdCountDown.SLTitleTmpl file (5) and click Open.

5
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5. The TSF_AdCountDown scripted title object will be loaded to
your title project:
●● in the object tree the added TSF_AdCountDown
object (6) and its elements are displayed;
●● in the working area of the project title elements of the
TSF_AdCountDown scripted object are displayed. After
the loading, all title elements have the same size and
location (7) specified in the template.

6

7

88

Important: You cannot change the composition, type and name of title

elements of the scripted object. But you can change the name of
the scripted object.

6. To start setting parameters of the scripted object, in the Object Tree window (1) click on the name of the TSF_AdCountDown
scripted object (2).

95

1
2

7. In the Properties window (3) in the Script Object table (4) set
the parameters values.

3

4

6

5

8. Specify values of the script parameters in the ScriptProperties list (5). If the list is minimized, expand it clicking on the
icon .
The script parametrs TSF_AdCountDown (6):
●● Mark name: an arbitrary set of characters. Notice that
the same set of characters should be specified as
mark when configuring the Start mark and Stop mark
commands in FDOnAir (for more information, see the
paragraph 2. «Scheduling details»);
●● Duration: the duration of the countdown timer
displaying (sec.);
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●● Execute always: set the True value, if you want the
TSF_AdCountDown scripted title object to ignore all
commands that deactivate any titles (ex. on the F7
button); if you set the False value, the scripted object
will be deactivated according to the commands that
deactivate any titles. This property was added to
facilitate the deactivating of all titles before the start
of advertisement except TSF_AdCountDown.
●● Background: a full path to the background image file
(optional parameter). If the file is not specified, the
background will not be displayed.
●● Use element: the title element to be used for the
countdown timer displaying:
●● Clock2: an element of the Clock2 type;
●● Clock3: an element of the Clock3 type.
9. Select a Clock2 or Clock3 element in the Object Tree window
in the group of the TSF_AdCountDown object (depending on
which element was set in the scripted object properties on
the previous step) and configure it.
For the Clock2 and Clock3 title elements the values of some
properties are set by default and cannot be edited, for
example, for the Mode of timing property the Count down and
hide value is set.
But you need to configure the editable element properties
such as Location, Size, etc.

„„

Tip: Find the detailed description of the Clock2 and Clock3 title

elements properties in the «Types of Title Elements» section in
the «FDTitle Designer. Title Project Editor» User’s Guide.

10. If you want to use a background image to be displayed,
configure the Backgr title element: set the values for the
Location, Size, and other properties (Align and Stretch, Stretch
Alpha, etc.).
11. Save the project.

5. Preview
For previewing of the TSF_AdCountDown scripted title object
work launch the schedule execution in FDOnAir. The
previewing is possible in the FDPreview or SLTitlePreview
windows.
For more information on how to preview in FDOnAir, see
the paragraphs 3. «Preview in FDPreview window (using
the board)» and 4. «Preview in window of SLTitlePreview
(without board)») of the «Preview» subsection of the «General
Information» section.
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TSF_RollCrawl: a scripted wrapper for the RollCrawl title element
1. Purpose

„„

Tip: We recommend you to read the description of the RollCrawl
title element in the «FDTitle Designer Title Project Editor»
User’s Guide.

The TSF_RollCrawl scripted object works in the same way as
the RollCrawl title element, but the scripted object has the
following additional features:
●● you can display a background image that turns on
during pauses in the tasks;
●● task item that can’t be played back entirely can be
played back in part.
Note:

the RollCrawl title element doesn`t play back the task item if it has
not enough time to play it back entirely.

If the work of the scripted object was stopped by a FDOnAir
command, during the next launch the scripted object will
execute the task item following the item has been executed
during the last session.

2. Task file
A task file for the TSF_RollCrawl scripted object is a text file with
the *.txt or *.spt extension.
For more information on how to create a task for the RollCrawl
title element see the «RollCrawl title element – Task editor for
the Roll Crawl title element» User’s Guide.

3. Title elements of the object
3.1. List of the elements
In the table below the title elements contained in the TSF_RollCrawl scripted title object are listed, specifying their type and
purpose.
Name

Type

Purpose

Main

Caption

Auxiliary element used by the script object during its work

Backgr

AnimLogo Used to display a background image

Crawl

RollCrawl

Used to display announce texts

3.2. Size and location
User can change size and location of any title element of the
TSF_RollCrawl scripted title object.
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4. Working with the scripted object
1. Preparation for work:
●● prepare your task file for the TSF_RollCrawl scripted
object using FDMovieListEditor (see p. 2 «Task file»);
●● prepare a style collection file for text design (*.efc). For
more information on how to create a style collection
file see the «ForwardTitling. Graphics Editor» User’s
Guide;
●● if you need to display a background, prepare a
corresponding image file.

2. In FDTitleDesigner create a title project or load one created
before where you need to add the scripted title object.
3. To load the scripted title object to your project select the
Import Object Template... command (2) in the File menu (1) or
open the context menu (3) clicking on the FDTitleDesigner
Object Tree panel and select the Import Object Template...
command (4).
1

3

2

4

4. In the Import Object Template... window that opens select the
TSF_RollCrawl.SLTitleTmpl file (5) and click Open (6).

5

6
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5. The TSF_RollCrawl scripted title object will be loaded to your
title project:
●● in the object tree the added TSF_RollCrawl object (7)
and its elements are displayed;
●● in the working area of the project title elements of
the TSF_RollCrawl scripted object are displayed. After
the loading all title elements have the same size and
location (8) specified in the template.

7

8

88

Important: You cannot change the composition, type and name of title

elements of the scripted object. But you can change the name of
the scripted object.

6. To start setting parameters of the scripted object, in the
Object Tree window (1) click on the name of the TSF_RollCrawl
scripted object (2).
1
2

3
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7. In the TaskName line (3) specify the name of your task file.
8. If the ScriptProperties list (4) is collapsed expand it clicking
on the
icon (5).

5

4

6

9. Specify values of the script parameters (6):
●● Interrupt the last – to allow the program to play back
partially the task item that cannot be played back
entirely because of lack of time.
●● False: do not allow. The task item will not be
played back.
●● True: allow. Duration of playing back of the last
item will be reduced.
●● Background: a full path to the background image file
(optional parameter);
10. In the Object Tree window select the Crawl title element and
configure it.
11. If you need to change the size, location or other parameters
of the background image, select the Backgr title element in
the Object Tree window and configure it.

„„

Tip: For more information on properties of title elements of

different types see the «Types of Title Elements» section on the
«FDTitleDesigner. Title Project Editor» User’s Guide.

12. Save your project.
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5. Preview
You can preview your project containing the TSF_RollCrawl
scripted object in the preview window of FDTitleDesigner.
For more information on working order see the «Previewing»
paragraph in the «General information» section.
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TSF_Ticker: a scripted wrapper for the RollCrawl title element
1. Purpose and features

„„

Tip: It is highly recommended to read more about the RollCrawl

title element in the «FDTitle Designer. Title Project Editor»
User’s Guide.
The TSF_Ticker scripted object is designed to display a crawl
line with text messages. It works in much the same way as the
RollCrawl title element, but the TSF_Ticker scripted object has the
following additional features:
●● when looped the script allows the looping of the
messages without a break between the last and first
message (the RollCrawl title element waits for the final
message to leave the screen before starting the first
message);
●● after each cycle the script automatically checks the
task file which allows the addition of new messages to
the line by editing the task file;
●● using the scripted object it is possible to display a
background for the crawl line. A background can be a
graphical or video file. The background automatically
appears and disappears with the crawl line.

2. Task file
The TSF_Ticker script uses a task file as the source of data – a
text file with the *.txt filename extension.
The task file contains lines with the message texts for the crawl
line. Each messages starts with a new line. The image shows an
example task file opened in Notepad.
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Formatting tags (1) can be added to the task file. For more
information on using tags see the «FDTitle Designer. Title
project editor» User’s Guide.

1

It is possible to include a substitution function. In order to do
this it is necessary to set up the corresponding settings (see
below). For more information on substitution see current User’s
Guide, chapter «General information», section «Substitution
file».

3. Object title elements
The table lists the title elements contained in a title object with
the TSF_Ticker, as well as their type and their purpose.
Name

Type

Purpose

Backgr

AnimLogo

Display of background image or video

Ticker

RollCrawl

Display of crawl line with messages

4. Operating procedure
1. Preliminary preparations:
●● prepare a task file with the message texts;
●● if necessary, prepare a graphical or video file for the
background;
●● prepare a file with the text style to be used (*.efc). For
a description of how to create a style collection file, see
the «ForwardTitling. Graphic editor» User’s Guide.
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2. In the FDTitle Designer program create a new or open an
existing title project to which the title object with the script
needs to be added.
3. In the File (1) menu select Import Оbject Template...(2) or open
the context menu of the Object tree panel (2) and select Import
Оbject Template...(3).

2
1

4. In the opened window select TSF_Ticker.SLTitleTmpl (4)
and press Open (5).

4
5
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5. The title object with the TSF_Ticker script will be added to
the title project:
●● the added TSF_Ticker object and its elements will
appear in the Object tree (6) and the project work
field (7);
●● all of the title elements will have the size and
placement set in the template.

6

7
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Impotant: It is impossible to change the types and names of the title

elements contained within the scripted object. It is possible to
change the name of the title object with the script.

6. To start configuring the script parameters left click the title
object with the TSF_Ticker script (1) in the Object tree.

1
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7. In the TaskName (2) field set the full path to the task file.
8. In the ScriptProperties group in the Background (3) line set the
full path to the background file if necessary.

2
3

9. If it is necessary to display a background for the crawl
line, select the Backgr (4) title element in the Object tree and
configure the necessary parameters (5).

4

5
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10. Select the Ticker (6) title element and configure its
parameters:
●● in the Alignment and Stretch (7) parameter group set the
alignment parameters of the crawl line text;
●● in the Specific (8) parameter group assign the values
of the speed and direction of the crawl line and, if
necessary, configure other available parameters;
●● in the Text Formatting (9) parameter group assign the
style collection file (*.efc);
●● if using a substitutes file, in the Substitutes (10)
parameter group set the substitutes file and the
separator symbol used in it.

6

7

8

9

10

11. Save the project.
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5. Preview
You can preview the work of the title object with the TSF_Ticker
in the FDTitle Designer prorgram window using the preview
mode.
For more information see the «General information section»,
paragraph «Preview».
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Useful Links
ForwardT Software set: description, download, documentation, solutions
http://www.softlab-nsk.com/forward/index.html

Support
e-mail: forward@sl.iae.nsk.su
forward@softlab-nsk.com
forward@softlab.tv

Forum
http://www.softlab-nsk.com/forum (currently available in Russian only)

Documentation for more information:
FDPreview. Program for Previewing of Audio and Video on Boards Inputs/Outputs
FDTitleDesigner. Title Project Editor
ForwardTitling. Graphic Editor
FDOnAir. Additional Sections
FDImageUpdater. Program for Organizing Dynamic Data Update in Titles
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